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Welcome to the Mercury Quality Center 
Tutorial

Welcome to the Mercury Quality Center Tutorial, a self-paced guide that 
teaches you how to use Mercury Quality Center (formerly TestDirector), the 
Mercury Web-based test management tool. 

This tutorial instructs you on how to use Quality Center to manage the 
application testing process. It familiarizes you with specifying testing 
requirements, planning tests, executing tests, and tracking defects. It also 
shows you how to monitor the testing process by creating reports and 
graphs.

Before You Begin

To do this tutorial, you must have access to these components from your 
machine:

Quality Center 8.2—Mercury’s Web-based test management tool. You must 
have access to these modules: Requirements, Test Plan, Test Lab, and 
Defects.

QualityCenter_Demo—a demonstration project that helps introduce you to 
Quality Center and includes sample requirements, tests, test sets, test runs, 
and defects.
v



Welcome
Note: It is highly recommended that you work on a new copy of the 
QualityCenter_Demo project. For more information, contact your Quality 
Center administrator.

Mercury Tours—a sample application that simulates a Web-based site for 
reserving flights, hotel rooms, car rentals, cruises, and vacation deals.

Note: To access the QualityCenter_Demo project and Mercury Tours, you 
must install these components while installing Quality Center. For more 
information, refer to the Mercury Quality Center Installation Guide.

QuickTest Professional or WinRunner—testing tools to run the automated 
tests used in this tutorial. Make sure that you enable your testing tool to 
work with other Mercury tools. For more information, refer to the user guide 
for your testing tool.

Note:

➤ To integrate Quality Center with QuickTest Professional, you must install 
the QuickTest Professional Add-in and the Mercury Quality Center 
Connectivity Add-in from the Mercury Quality Center Add-ins page. 

➤ To integrate Quality Center with WinRunner, you must install the Mercury 
Quality Center Connectivity Add-in from the Mercury Quality Center 
Add-ins page.

For more information, refer to the Mercury Quality Center Installation Guide.
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Using This Tutorial

This tutorial contains the following lessons: 

 Lesson 1 Introducing Quality Center

Introduces you to the Quality Center testing process, and familiarizes you 
with the Quality Center user interface and the sample Mercury Tours Web 
site.

 Lesson 2 Specifying Testing Requirements

Shows you how to define requirements, view and modify the requirements 
tree, and convert requirements.

 Lesson 3 Planning Tests

Shows you how to create a test plan tree, design test steps, copy test steps, 
call a test with parameters, link tests to requirements, and automate your 
manual tests.

 Lesson 4 Running Tests

Shows you how to define test sets, schedule test runs, and run manual and 
automated tests.

 Lesson 5 Adding and Tracking Defects

Shows you how to add new defects, search for similar defects, update 
defects, e-mail defects, associate defects with tests, trace changes, and create 
favorite views.

 Lesson 6 Tracing Changes

Shows you how to keep track of changes made to your requirements, tests, 
and defects as you perform your project testing.
vii



Welcome
 Lesson 7 Analyzing the Testing Process

Shows you how to monitor the testing process by creating reports and 
graphs.

 Lesson 8 Where Do You Go from Here?

Shows you how to start testing your own application and where to find 
more information about Quality Center.

Documentation Updates

Mercury Interactive is continuously updating its product documentation 
with new information. You can download the latest version of this 
document from the Customer Support Web site (http://support.mercury.com).

To download updated documentation:

 1 In the Customer Support Web site, click the Documentation link.

 2 Under Please Select Product, select Mercury Quality Center.

Note that if Quality Center does not appear in the list, you must add it to 
your customer profile. Click My Account to update your profile.

 3 Click Retrieve. The Documentation page opens and lists the documentation 
available for the current release and for previous releases. If a document was 
recently updated, Updated appears next to the document name.

 4 Click a document link to download the documentation.
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Welcome
Typographical Conventions

This book uses the following typographical conventions:

1, 2, 3 Bold numbers indicate steps in a procedure.

➤ Bullets indicate options and features.

> The greater than sign separates menu levels (for 
example, File > Open).

Stone Sans The Stone Sans font indicates names of interface 
elements in a procedure that you perform actions 
upon (for example, “Click the Run button.”).

Bold Bold text indicates function names.

Italics Italic text indicates variable names, or introduces a 
new term.

Arial The Arial font is used for examples and statements that 
are to be typed in literally.

<> Angle brackets enclose a part of a URL address that 
needs to be typed in.

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included.
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1
Introducing Quality Center

Application testing is a complex process. Quality Center helps you organize 
and manage all phases of the application testing process, including 
specifying testing requirements, planning tests, executing tests, and tracking 
defects.

In this lesson, you will learn about:

➤ The Quality Center Testing Process

➤ Starting Quality Center

➤ The Quality Center Window

➤ The Mercury Tours Sample Web Site

The Quality Center Testing Process

Quality Center offers an organized framework for testing applications before 
they are deployed. Because test plans evolve with new or modified 
application requirements, you need a central data repository for organizing 
and managing the testing process. Quality Center guides you through the 
requirements specification, test planning, test execution, and defect 
tracking phases of the testing process.

The Quality Center testing process includes four phases:

Specif ying
Requirement s
Specif ying

Requirement s
Planning
Test s
Planning
Test s

Running
Test s
Running
Test s

Track ing
Def ect s
Track ing
Def ect s
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Lesson 1 • Introducing Quality Center
Specifying Requirements

You begin the application testing process by specifying testing requirements. 
In this phase you perform these tasks:

Planning Tests

You create a test plan based on your testing requirements. In this phase you 
perform these tasks:

Task Description

Define Testing Scope Examine application documentation to determine 
your testing scope—test goals, objectives, and 
strategies.

Create Requirements Build a requirements tree to define your overall testing 
requirements.

Detail Requirements For each requirement topic in the requirements tree, 
create a list of detailed testing requirements. Describe 
each requirement, assign it a priority level, and add 
attachments if necessary.

Analyze Requirements 
Specification

Generate reports and graphs to assist in analyzing your 
testing requirements. Review your requirements to 
ensure that they meet your testing scope.

Task Description

Define Testing Strategy Examine your application, system environment, and 
testing resources to determine your testing goals.

Define Test Subjects Divide your application into subjects or functions to 
be tested. Build a test plan tree to hierarchically divide 
your application into testing units, or subjects.

Define Tests Determine the types of tests you need for each subject. 
Add a basic definition of each test to the test plan tree.

Create Requirements 
Coverage

Link each test with a testing requirement(s).
2



Lesson 1 • Introducing Quality Center
Running Tests

After you build a test plan tree, you run your tests to locate defects and 
assess quality. In this phase you perform these tasks:

Design Test Steps Develop manual tests by adding steps to the tests in 
your test plan tree. Test steps describe the test 
operations and the expected outcome of each test. 
Decide which tests to automate.

Automate Tests For tests that you decide to automate, create test 
scripts with a Mercury testing tool, or a custom or 
third-party testing tool.

Analyze Test Plan Generate reports and graphs to assist in analyzing test 
planning data. Review your tests to determine their 
suitability to your testing goals.

Task Description

Create Test Sets Define groups of tests to meet the various testing goals 
in your project. These might include, for example, 
testing a new version or a specific function in an 
application. Determine which tests to include in each 
test set.

Schedule Runs Schedule test execution and assign tasks to testers. 

Run Tests Execute the tests in your test set automatically or 
manually.

Analyze Test Results View the results of your test runs to determine 
whether a defect has been detected in your 
application. Generate reports and graphs to help 
analyze these results.

Task Description
3



Lesson 1 • Introducing Quality Center
Tracking Defects

Locating and repairing application defects efficiently is essential to the 
testing process. Defects can be detected and added during all stages of the 
testing process. In this phase you perform these tasks:

Task Description

Add Defects Report new defects detected in your application. 
Quality assurance testers, developers, project 
managers, and end users can add defects during any 
phase in the testing process.

Review New Defects Review new defects and determine which ones should 
be fixed.

Repair Open Defects Correct the defects that you decided to fix.

Test New Build Test a new build of your application. Continue this 
process until defects are repaired.

Analyze Defect Data Generate reports and graphs to assist in analyzing the 
progress of defect repairs, and to help determine when 
to release the application.
4



Lesson 1 • Introducing Quality Center
Starting Quality Center

You start Quality Center from your Web browser, using the Mercury Quality 
Center URL.

To start Quality Center:

 1 Open the Mercury Quality Center Options window.

In your Web browser, type your Mercury Quality Center URL:
http://<Mercury Quality Center server name>/<virtual directory 
name>/default.htm

The Mercury Quality Center Options window opens.

Note: If you cannot start Quality Center, contact your system administrator 
to ensure that Quality Center has been installed on your company Web 
server. 
5



Lesson 1 • Introducing Quality Center
 2 Open Quality Center.

Click the Mercury Quality Center link.

The first time you run Quality Center, the application is downloaded to 
your computer. Then, each time you open Quality Center, it automatically 
carries out a version check. If Quality Center detects a newer version, it 
downloads the latest version to your machine. 

The Mercury Quality Center Login window opens.

 3 Select a domain.

In the Domain list, select DEFAULT. 

 4 Select a project.

In the Project list, select QualityCenter_Demo. 

Note: If more than one QualityCenter_Demo project is listed, contact your 
Quality Center administrator to determine which project to use.
6



Lesson 1 • Introducing Quality Center
 5 Log on to the project as a QA tester.

In the User ID box, type one of these user names: alice_qc, cecil_qc, or 
michael_qc.

Skip the Password box. A password was not assigned to any of the above 
user names.

Click the Login button. 

Quality Center opens and if you were working before, displays the module 
in which you were last working. In the title bar, your project name and your 
user name are displayed.

The Quality Center Window

In this exercise, you will explore the Quality Center modules and their 
common elements.

To explore the Quality Center window:

 1 Explore the Quality Center modules.

➤ Click the Requirements button on the sidebar. The Requirements module 
enables you to specify your testing requirements. This includes defining 
what you are testing, defining requirement topics and items, and analyzing 
the requirements.

➤ Click the Test Plan button on the sidebar. The Test Plan module enables you 
to develop a test plan based on your testing requirements. This includes 
defining goals and strategies, dividing your plan into categories, developing 
tests, automating tests where beneficial, and analyzing the plan.

➤ Click the Test Lab button on the sidebar. The Test Lab module enables you 
to run tests on your application and analyze the results.

➤ Click the Defects button on the sidebar. The Defects module enables you to 
add defects, determine repair priorities, repair open defects, and analyze the 
data.
7



Lesson 1 • Introducing Quality Center
Note: Depending on your Quality Center license, you may also have access 
to additional modules:

➤ Click the Business Components button on the sidebar. The Business 
Process Testing module enables subject matter experts to drive the 
quality optimization process. For more information, refer to the Mercury 
Business Process Testing User’s Guide.

➤ Click the Dashboard button in the sidebar. The Application Delivery 
Dashboard enables IT teams to track application readiness in real-time 
and manage project risk. For more information, refer to the Mercury 
Application Delivery Dashboard documentation set. 

 2 Explore the common Quality Center elements.

All the Quality Center modules have common elements. For example, click 
the Requirements button on the sidebar.
8



Lesson 1 • Introducing Quality Center
Each of the Quality Center modules contains these key elements:

➤ The Quality Center toolbar is located directly above the project name. If 
the toolbar is not visible, click the Show Toolbar button. The common 
Quality Center toolbar is accessible from all Quality Center modules and 
contains these buttons:

➤ The menu bar, located directly below the Quality Center project name, 
displays the names of menus from which you select commands. 

➤ The module toolbar, located below the menu bar, contains buttons for 
frequently-used commands in the current Quality Center module.

Button Description

Back: Navigates back to your previous location in Quality Center.

Forward: If you navigated back, enables you to navigate forward.

Check Spelling: Checks the spelling for the selected word or text 
box. If there are no errors, a confirmation message opens. If errors 
are found, the Spelling dialog box opens and displays the word 
together with replacement suggestions.

Spelling Options: Opens the Spelling Options dialog box, enabling 
you to configure the way Quality Center checks spelling.

Thesaurus: Opens the Thesaurus dialog box and displays a 
synonym, antonym, or related word for the selected word. You can 
replace the selected word or look up new words.

Add Defect: Opens the Add Defect dialog box, enabling you to add 
a new defect.

Trace All Changes: Opens the Trace All Changes dialog box, 
enabling you to view traceability alerts. 

Help: Opens the Online Help and displays the help topic for the 
current context.
9



Lesson 1 • Introducing Quality Center
➤ The Tools button, located on the upper-right side of the window, enables 
you to change your user password and other user properties, open the 
Document Generator, and view version information for each Quality 
Center client component. 

➤ The Help button, located on the upper-right side of the window, enables 
you to access Quality Center’s online resources. 

➤ The Logout button, located on the upper-right side of the window, 
enables you to exit and return to the Mercury Quality Center Login 
window.
10



Lesson 1 • Introducing Quality Center
The Mercury Tours Sample Web Site

Mercury Tours is the sample Web application used in this tutorial. It 
simulates a Web-based application for reserving flights, hotel rooms, car 
rentals, cruises, and vacation deals. You should now familiarize yourself 
with this application.

To explore Mercury Tours:

 1 Open the Mercury Tours application.

Open a separate instance of your Web browser, and type this URL: 
http://<Quality Center server name>/mtours/index.html

The Mercury Tours home page opens.
11



Lesson 1 • Introducing Quality Center
 2 Subscribe to Mercury Tours.

Click Register here. The Register page opens. 

Type your Contact Information, Mailing Information, and User Information, 
in the relevant fields. 

Click Submit. A confirmation of your registration is displayed in the Register 
page.
12



Lesson 1 • Introducing Quality Center
 3 Log on to Mercury Tours. 

Click the sign-in link. The Sign-on page opens. 

In the User Name and Password boxes, type your user name and password. 
Click Submit.
13



Lesson 1 • Introducing Quality Center
The Flight Finder page opens.

 4 Reserve a flight. 

Follow the on-screen instructions to reserve a flight. 

 5 Explore other options.

Explore these options: Hotels, Car Rentals, Cruises, Destinations, and 
Vacations.

 6 End your Mercury Tours session. 

Click Sign-off to log off.

Now that you are familiar with the Quality Center testing process, the 
Quality Center modules, and the Mercury Tours sample Web site, you can 
proceed to Lesson 2, “Specifying Testing Requirements”.
14



2
Specifying Testing Requirements

You begin the testing process by specifying testing requirements in the 
Requirements module. Requirements describe in detail what needs to be 
tested in your application and provide the test team with the foundation on 
which the entire testing process is based.

You define the requirements in Quality Center by creating a requirements 
tree. This is a graphical representation of your requirements specification, 
displaying your requirements hierarchically. You can group and sort 
requirements in the tree, monitor task allocation, monitor the progress in 
meeting requirements, and generate detailed reports and graphs.

After you create tests in the Test Plan module, you can link requirements to 
tests (see “Planning Tests” on page 27). Later, after you begin logging 
defects, you can also associate requirements with defects (see “Adding and 
Tracking Defects” on page 79). In this way, you can keep track of your 
testing needs at all stages of the testing process. If a testing requirement 
changes, you can immediately identify which tests and defects are affected, 
and who is responsible for them.

In this lesson, you will learn about:

➤ Defining Requirements

➤ Viewing Requirements

➤ Modifying Requirements

➤ Converting Requirements
15



Lesson 2 • Specifying Testing Requirements
Defining Requirements

In this exercise, you will define requirements for testing the functionality of 
reserving cruises in Mercury Tours. 

To define a requirement:

 1 Open the QualityCenter_Demo project.

If the QualityCenter_Demo project is not already open, log on to the 
project. For more information, see “Starting Quality Center” on page 5.

 2 Display the Requirements module.

Click the Requirements button on the sidebar to display the requirements 
tree.

 3 Display the requirements tree in Document View.

Make sure the Document View of the requirements tree is displayed. 

Note: This lesson uses the Document View. For more information on the 
other views, see “Creating and Viewing Requirements Coverage” on 
page 41.
16



Lesson 2 • Specifying Testing Requirements
 4 Create a new requirement.

Click the New Requirement button. The New Requirement dialog box 
opens.

Type or select the following:

Name: Cruise Reservation 

Product: Mercury Tours (HTML Edition)

Priority: 4-Very High

Type: Functional

Click OK. The Cruise Reservation requirement is added to the requirements 
tree.

 5 Add a child requirement.

In the requirements tree, make sure that the new Cruise Reservation 
requirement is selected.

Click the New Child Requirement button to add a requirement below Cruise 
Reservation, at a lower hierarchical level. The New Requirement dialog box 
opens.

Type or select the following:

Name: Cruise Search 

Product: Mercury Tours (HTML Edition)

Priority: 4-Very High

Type: Functional

Click OK. The Cruise Search requirement is added as a child of the Cruise 
Reservation requirement.
17



Lesson 2 • Specifying Testing Requirements
 6 Add an additional child requirement.

In the requirements tree, select Cruise Reservation.

Repeat step 5. This time in the Name box, type Cruise Booking. 

The Cruise Booking requirement is added as a child of the Cruise 
Reservation requirement.

Viewing Requirements

You can change the way requirements are displayed in the requirements 
tree. In this exercise, you will learn how to zoom in and out of the tree and 
display numeration.

To view requirements:

 1 Make sure the Requirements module is displayed.

If the Requirements module is not displayed, click the Requirements button 
on the sidebar to display the requirements tree. 

Make sure the requirements tree is displayed in Document View.

 2 Zoom in and out of the requirement.

Select Cruise Reservation in the requirements tree.
18
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To zoom in, click the Zoom In button on the toolbar. The requirements tree 
displays only the child requirements of Cruise Reservation.

To reverse the zoom in action and display the entire requirements tree, click 
the Zoom In arrow and choose Zoom Out To Root.

 3 Display numeration in the requirements tree.

To assign hierarchical numbers to each requirement in the tree, choose 
View > Numeration. As you make changes to the tree, the requirements are 
automatically renumbered. Note that the numbers are not related to the 
unique ReqID assigned to each requirement. 

 4 Remove the numeration from the requirements tree.

To remove the hierarchical numbering, choose View > Numeration.
19



Lesson 2 • Specifying Testing Requirements
Modifying Requirements

You can modify the requirements in the requirements tree. In this exercise, 
you will learn how to copy, rename, move, or delete requirements.

To modify requirements:

 1 Make sure the Requirements module is displayed.

If the Requirements module is not displayed, click the Requirements button 
on the sidebar to display the requirements tree. 

 2 Copy a requirement.

In the requirements tree, select Cruise Reservation and click the Copy 
button. 

Click the Paste button. 

A warning box opens because you are duplicating the requirement name. 
Click OK. The requirement is pasted below the selected requirement, at the 
same hierarchical level. _Copy_ is added to the end of the requirement’s 
name. 

 3 Rename the Cruise Reservation_Copy_ requirement.

Right-click the Cruise Reservation_Copy_ requirement and choose Rename.

Edit the requirement name to Hotel Reservation and press Enter.

 4 Move the Hotel Reservation requirement to a different location in the 
requirements tree.

Select Hotel Reservation. 

Click the Cut button.

Select Reservations Management.

To paste Hotel Reservation below the selected requirement, click the Paste 
arrow and choose Paste as Child. 
20
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Click Yes to confirm. 

Tip: You can also drag requirements to a new location in the requirements 
tree.

 5 Delete the Hotel Reservation requirement.

Select Hotel Reservation.

Click the Delete button. 

Click Yes to confirm. The requirement and its children are deleted.

Converting Requirements

After you create the requirements tree, you use the requirements as a basis 
for defining your test plan tree in the Test Plan module. For more 
information, see Lesson 3, “Planning Tests” on page 27.

You can use the Convert to Tests wizard to assist you when designing your 
test plan tree. The wizard enables you to convert selected requirements or all 
requirements in the requirements tree to tests or subjects in the test plan 
tree.

In this exercise, you will convert the Cruise Reservation requirement to a 
subject in the test plan tree, and the child requirements of Cruise 
Reservation to tests.
21



Lesson 2 • Specifying Testing Requirements
To convert a requirement:

 1 Make sure the Requirements module is displayed.

If the Requirements module is not displayed, click the Requirements button 
on the sidebar to display the requirements tree. 

 2 Select a requirement.

In the requirements tree, select Cruise Reservation. 

 3 Open the Convert to Tests wizard.

Choose Tools > Convert to Tests > Convert Selected. The Step 1 dialog box 
opens.

 4 Choose an automatic conversion method.

Select the second option, Convert lowest child requirements to tests, to 
convert the selected requirements to tests.
22
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 5 Start the conversion process.

Click Next to begin converting the requirements. When the conversion 
process is complete, the results are displayed in the Step 2 dialog box.
23
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 6 Convert Cruise Search to a step and restore it.

Select Cruise Search and click the Convert to Step button. The Cruise Search 
test is converted to a step.

With Cruise Search selected, click the Convert to Test button. The Cruise 
Search step is converted back to a test.

Click Next. The Step 3 dialog box opens.
24
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 7 Choose the destination subject path.

In the Destination Subject Path box, click the browse button. The Select 
Destination Subject dialog box opens.

In the test plan tree, select the Cruises subject.

Click OK to close the Select Destination Subject dialog box. The Destination 
Subject Path box now indicates this path:

 8 Finalize the conversion process.

Click Finish. 

Click OK to confirm.
25



Lesson 2 • Specifying Testing Requirements
 9 View the tests in the test plan tree.

Click the Test Plan button on the sidebar to display the Test Plan module.

In the test plan tree, select Cruises and click the Refresh Selected button. 
The test plan tree displays Cruise Reservation under Cruises. 

Expand Cruise Reservation. The test plan tree displays the Cruise Booking 
and Cruise Search manual tests.

Now that you are familiar with defining requirements, viewing and 
modifying the requirements tree, and converting requirements, you can 
proceed to Lesson 3, “Planning Tests”. In Lesson 3, you will learn how to 
define your test plan tree. 
26
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Planning Tests

After you define your requirements, you need to determine your testing 
goals. To do this, examine your application, system environment, and 
testing process to outline the testing strategy for achieving your goals. 

After you determine your testing goals, you build a test plan tree, which 
hierarchically divides your application into testing units, or subjects. For 
each subject in the test plan tree, you define tests that contain steps.

For each test step, you specify the actions to be performed on your 
application and the expected result. You can increase the flexibility of a test 
step by adding parameters.

To keep track of the relationship between your tests and your requirements, 
you can add links between them. By creating links, you ensure compliance 
with your requirements throughout the testing process. 

After you design your tests, you can decide which tests to automate. When 
you automate a test, you can generate a test script and then complete it 
using other Mercury testing tools (for example, QuickTest Professional or 
WinRunner).

In this lesson, you will learn about:

➤ Developing a Test Plan Tree

➤ Designing Test Steps

➤ Copying Test Steps

➤ Calling Tests with Parameters

➤ Creating and Viewing Requirements Coverage 

➤ Generating Automated Test Scripts
27



Lesson 3 • Planning Tests
Developing a Test Plan Tree

The typical application is too large to test as a whole. The Test Plan module 
enables you to divide your application according to functionality. You 
divide your application into units, or subjects, by creating a test plan tree. The 
test plan tree is a graphical representation of your test plan, displaying your 
tests according to the hierarchical relationship of their functions. After you 
define subjects in the tree, you decide which tests to create for each subject 
and add them to the tree.

In Lesson 2, you converted the Cruise Reservation requirement and its child 
requirements to subjects and tests in the test plan tree (see “Converting 
Requirements” on page 21). In this exercise, you will add a subject and a test 
to the test plan tree in the Test Plan module.

To develop a test plan tree:

 1 Open the QualityCenter_Demo project.

If the QualityCenter_Demo project is not already open, log on to the 
project. For more information, see “Starting Quality Center” on page 5.

 2 Display the Test Plan module.

Click the Test Plan button on the sidebar. 

 3 Add a subject folder to the test plan tree.

Select the Cruises subject folder and click the New Folder button. The New 
Folder dialog box opens.

In the Folder Name box, type Cruise Cancellation. Click OK. The new subject 
folder appears under the Cruises subject folder in the test plan tree. 
28



Lesson 3 • Planning Tests
In the Description tab in the right pane, type a description of the subject: 
This folder contains tests that verify the Cancel Reservation functionality.

 4 Add a test to the subject folder.

Select Cruise Cancellation and click the New Test button. The Create New 
Test dialog box opens.

In the Test Type box, select QUICKTEST_TEST to create a QuickTest 
Professional test, or select WR-AUTOMATED to create a WinRunner test. 

Notes:

➤ The QUICKTEST_TEST test type is only available if you have installed the 
QuickTest Professional Add-in from the Mercury Quality Center Add-ins 
page. For more information on installing the add-in, refer to the Mercury 
Quality Center Installation Guide.

➤ If you selected QUICKTEST_TEST from the Test Type list, the Template 
box is available. You can create your new test based on another QuickTest 
Professional test, defined as a template test. Quality Center copies the 
template test to your new test without the test results.

In the Test Name box, type a name for the test: Cancel All Reservations. 
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Click OK. The Required Fields dialog box opens.

Select the following:

Level: Basic 

Reviewed: Not Reviewed

Priority: 4-Very High

Click OK. 

The new test is added to the test plan tree under the Cruise Cancellation 
subject folder.

 5 Add a test description.

In the Details tab, you can see the test name, test designer, creation date, test 
status, and other information.

In the Description box, type a description for the test: The test verifies 
cancellation of cruise reservations in the Itinerary page.
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Designing Test Steps

After you add a test to the test plan tree and define basic test information, 
you define test steps—detailed, step-by-step instructions that specify how to 
execute a test. A step includes the actions to be performed on your 
application and the expected results.

You can create test steps for both manual and automated tests. For manual 
tests, you complete test planning by designing the test steps. Using your 
plan, you can begin test execution immediately. For automated tests, you 
create an automated test script using a Mercury testing tool, a custom 
testing tool, or a third-party testing tool. 

In this exercise, you will create the Cruise Booking test. This test verifies the 
process of booking a cruise through the Mercury Tours site. 

To design a test step:

 1 Make sure the Test Plan module is displayed.

If the Test Plan module is not displayed, click the Test Plan button on the 
sidebar. 

 2 Display the Cruise Booking test.

Under the Cruise Reservation folder, select the Cruise Booking test.
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 3 Open the Design Step Editor.

Click the Design Steps tab.

Click the New Step button. The Design Step Editor opens. 

In the Step Name box, a step name is displayed. The default name is the 
sequential number of the test step (Step 1 if you are adding steps to a test for 
the first time). 
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 4 Define a step for displaying the Cruise Special page.

In the Design Step Editor, type the following:

Step Name: Display the Cruise Special page. 

Description: Click the Cruises button. 

Expected Result: The Cruise Special page opens. 

 5 Define a step for reserving the cruise.

In the Design Step Editor, click the New Step button. The Step Name box 
displays Step 2.

Type the following:

Step Name: Display the Cruise Reservation page.

Description: Click the Now Accepting Reservations button.

Expected Result: The Cruise Reservation page opens.
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 6 Define a step for booking the cruise.

In the Design Step Editor, click the New Step button. The Step Name box 
displays Step 3.

Type the following:

Step Name: Book the cruise.

Description: Enter passenger name, credit card information, and address. Click 
OK. 

Expected Result: The Cruise Confirmation page opens.

 7 Define a step for printing the cruise confirmation information.

In the Design Step Editor, click the New Step button. The Step Name box 
displays Step 4.

Type the following:

Step Name: Print cruise confirmation.

Description: Click the Print button. 

Expected Result: A confirmation page is printed.

 8 Define a step for logging off the Mercury Tours site.

In the Design Step Editor, click the New Step button. The Step Name box 
displays Step 5.

Type the following:

Step Name: Log off.

Description: Click the Sign-Off button. 

Expected Result: Returns to the Sign-On page.
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 9 Close the Design Step Editor.

Click OK. The Design Steps tab displays the design steps.
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Copying Test Steps

You can copy steps from another test in the same project or from a different 
project. In this exercise, you will copy the test steps from the Cruise Booking 
test and paste them into the Cruise Search test. 

To copy a test step:

 1 Display the Design Steps tab for the Cruise Booking test.

In the test plan tree, under Cruise Reservation, select the Cruise Booking 
test.

Click the Design Steps tab.

 2 Select the steps that you want to copy.

Position the mouse pointer in the gray sidebar on the left. The mouse 
pointer changes to . Press the Shift or Ctrl key and select all the steps.

 3 Copy the selected steps.

Click the Copy Steps button.
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 4 Paste the steps in the Cruise Search test.

In the test plan tree, under Cruise Reservation, select the Cruise Search test.

In the Design Steps tab, click the Paste Steps button. The test steps are 
copied to the Design Steps tab.

Calling Tests with Parameters

When you design test steps, you can include a call to a manual test. When 
you run the test, the test steps include the steps from the called test as part 
of the test. The test that you call is a template test. This is a reusable test that 
can be called by other tests. A template test can include parameters. A 
parameter is a variable that replaces a fixed value. You can modify the value 
of a parameter according to the test that is calling it, or for various instances 
of the same test. 

For example, suppose you have a test that logs in a user with a specific 
password when you start your application. You need to call this test at the 
beginning of each test. In some cases, you may want to log on as a regular 
user while in other cases, you may want to log on as the administrator. To 
accomplish this, you create two parameters, <<<user name>>> and 
<<<password>>>, and modify the value of each parameter according to the 
type of test that is calling your template test.

In “Designing Test Steps” on page 31, you created a test for booking a cruise. 
In this exercise, you will enhance your test by calling the Connect And Sign-
On test. This template test includes parameters for the Mercury Tours URL 
address and for the user name and password used to log on to the site.
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To call a test with parameters:

 1 Display the Design Steps tab for the Cruise Booking test.

In the test plan tree, under Cruise Reservation, select the Cruise Booking 
test.

Click the Design Steps tab.

 2 Select the test with parameters that you want to call.

Click the Call to Test button. The Select a Test dialog box opens.

In the Find box, type Connect, and click the Find button. The Connect And 
Sign-On test is highlighted.
38



Lesson 3 • Planning Tests
Click OK. The Parameters of Test dialog box opens and displays the 
parameters contained in the called test.

 3 Assign values to the parameters.

In the Value column, type the following:

mercury tours url: http://<Quality Center server name>/mtours/index.html

password: Leave blank. You will assign a value to this parameter when you 
run your test (see “Running Tests Manually” on page 66).

user name: your user name (use the same name as the one used in Mercury 
Tours on page 11).

Note: You can also assign values to parameters when you create a test that 
calls your test, when you add your test to a test set, or when you run your 
test. 

Click OK. The Call Connect And Sign-On step is added to your design steps.
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 4 Reorder the steps.

Position the mouse pointer on the gray sidebar to the left of the Call 
Connect And Sign-On step. The mouse pointer changes to . Click and drag 
the step to the top row.

 5 Adjust the size of the rows.

Click the Adjust Rows Height button. Quality Center expands the size of the 
rows in which the text is too long to view. Note that if you close and reopen 
the Design Steps tab, the default row size is restored.
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Creating and Viewing Requirements Coverage

It is essential that the tests in your test plan comply with your testing 
requirements. To help ensure compliance throughout the testing process, 
you can add links between your tests in the Test Plan module and your 
requirements in the Requirements module.

In the Test Plan module, you create requirements coverage by selecting 
requirements to link to a test. Alternatively, in the Requirements module, 
you create tests coverage by selecting tests to link to a requirement. A test can 
cover more than one requirement, and a requirement can be covered by 
more than one test.

To further ensure compliance with your testing requirements, after you log 
defects, you can link your tests to defects (see “Associating Defects with 
Tests” on page 89). This ensures that if a requirement changes, you can 
identify which tests and defects are affected, and who is responsible for 
them.

In these exercises, you will create requirements coverage and tests coverage. 
You will also view a graphic representation of tests coverage.

Linking Requirements to a Test

In this exercise you will view existing requirements coverage for the Cruise 
Booking test and create new requirements coverage by linking the View 
Reservations requirement to the Cruise Booking test.

To link a requirement to a test:

 1 Make sure that the Test Plan module is displayed.

If the Test Plan module is not displayed, click the Test Plan button on the 
sidebar. 

 2 Display the Cruise Booking test.

Under the Cruise Reservation folder, select the Cruise Booking test.
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 3 Display the Reqs Coverage tab.

In the right pane, click the Reqs Coverage tab. The existing requirements 
coverage is displayed in the coverage grid. Note that the Cruise Booking 
requirement is already linked to the Cruise Booking test because you 
converted the requirement to a test (see “Converting Requirements” on 
page 21).

 4 Display the requirements tree.

Click the Select Req button to show the requirements tree on the right.

 5 Search for the View Reservations requirement in the requirements tree.

In the Find box, type View and click the Find button. The View Reservations 
requirement is highlighted in the tree.

 6 Add the requirement to the coverage grid.

Click the Add to Coverage (Include Children) button. The View 
Reservations requirement is added to the coverage grid. 

Tip: You can also drag a requirement or requirement topic in the 
requirements tree to the coverage grid.

 7 Hide the requirements tree.

Click the Close button.

coverage grid

requirements 
tree
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Linking Tests to a Requirement

In this exercise, you will create tests coverage by linking the Cruise Search 
test to the Cruise Booking requirement.

To link a test to a requirement:

 1 Display the Requirements module.

Click the Requirements button on the sidebar. 

 2 Display the requirements tree in Coverage View.

Select the Coverage View of the requirements tree. 

The Test Coverage tab is displayed in the right pane. 

 3 Display the Cruise Booking requirement.

In the requirements tree, under Cruise Reservation, select the Cruise 
Booking requirement. The existing tests coverage is displayed in the 
coverage grid. Note that the Cruise Booking test is already linked to the 
Cruise Booking requirement because you generated the test from the 
requirement (see “Converting Requirements” on page 21). 
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 4 Display the test plan tree.

In the Tests Coverage tab, click the Select Tests button to show the test plan 
tree on the right.

 5 Select the Cruise Search test in the test plan tree.

In the Cruises folder, expand the Cruise Reservation sub-folder.

Select the Cruise Search test.

 6 Add the test to the coverage grid.

Click the Add to Coverage button. The Cruise Search test is added to the 
coverage grid. 

Tip: You can also drag a test or a subject folder in the test plan tree to the 
coverage grid.

 7 Hide the test plan tree.

Click the Close button.

coverage 
grid

test plan 
tree
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Analyzing Tests Coverage

After you create tests coverage, you can use the Coverage Analysis View in the 
Requirements module to analyze the breakdown of child requirements 
according to tests coverage. 

In this exercise, you will analyze the Mercury Tours Application 
requirement. In the Coverage Analysis View, you will see that five of the 
requirement’s children have a “Failed” status (one or more of the tests 
covered by the requirement failed) and seven have a “Not Covered” status 
(the requirement has not been linked to a test). You will then analyze the 
failed requirements in more detail.

To analyze tests coverage:

 1 Make sure that the Requirements module is displayed.

If the Requirements module is not displayed, click the Requirements button 
on the sidebar.

 2 Display the requirements tree in Coverage Analysis View.

Select the Coverage Analysis View of the requirements tree. 

The Coverage Analysis View is displayed. 
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 3 Display the Mercury Tours Application requirement in Coverage 
Analysis View.

Expand the Mercury Tours Application requirement and its children.

You can see that this requirement has a Direct Cover Status of “Failed”. In 
the Coverage Analysis column, you can see graphically that of the 10 
children, only three have “Failed” and seven are not yet covered.

 4 Display coverage analysis for the Mercury Tours Application 
requirement.

Select the Mercury Tours Application requirement and click the Coverage 
Analysis button. The Coverage Analysis dialog box opens.

This graph displays the three “Failed” requirements in red and the seven 
“Not Covered” requirements in gray.
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 5 Display the child requirements with a “Failed” status.

Click the red Failed area of the graph. The child requirements with a 
“Failed” status are listed.

Note that you can select a requirement and click Go To to highlight the 
requirement in the requirements tree.

 6 Display tests coverage for the requirement.

Click the Show Tests Coverage link to extend the Coverage Analysis dialog 
box and display the Tests Coverage Chart. 

You can see, for example, that 19 of the tests associated with the Mercury 
Tours Application requirement have a “Failed” status. The Mercury Tours 
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Application requirement has a direct cover status of “Failed” because 32.2% 
of the tests associated with this requirement failed.

Note that you can click a section of the chart to open the Tests Coverage 
dialog box and display the list of tests with the selected status.

 7 Close the Coverage Analysis dialog box.

Click the Close button. 

Generating Automated Test Scripts

Test planning involves deciding which tests to automate. If you choose to 
perform tests manually, the tests are ready for execution as soon as you 
define the test steps. If you choose to automate tests, you can generate test 
scripts and complete them using other Mercury testing tools (for example, 
QuickTest Professional or WinRunner).

Consider these issues when deciding whether to automate a test.

In this exercise, you will generate an automated test script for the Cruise 
Search test.

Do automate: • Tests that will run with each new version of your 
application to check the stability of basic functionality 
across the entire application (regression test). 

• Tests that use multiple data values for the same 
operation (data-driven tests). 

• Tests that are run many times (stress tests) and tests that 
check a multi-user client/server system (load tests). 

Do not automate: • Tests that will be executed only once.

• Tests that require immediate execution.

• Tests that check how easy the application is to use 
(usability tests).

• Tests that do not have predictable results.
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To generate an automated test script:

 1 Display the Test Plan module.

Click the Test Plan button on the sidebar. 

 2 Locate the Cruise Search manual test to automate.

Select the Subject folder at the root of the test plan tree and click the Find 
Folder/Test button. The Find Folder/Test dialog box opens.

Do the following:

Value To Find: Type Cruise.

Include Tests: Select this checkbox to search for folders and tests.

Click Find. The Search Results dialog box opens and displays a list of 
possible matches.

Select Cruises\Cruise Reservation\Cruise Search and click the Go To button 
to highlight the test in the test plan tree.

 3 Display the Design Steps tab.

In the right pane, click the Design Steps tab.

 4 Generate a test script.

Click the Generate Script button.

Choose QUICKTEST_TEST to generate a QuickTest Professional test, or 
choose WR-AUTOMATED to generate a WinRunner test.
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Note: The QUICKTEST-TEST test type is only available if you have installed 
the QuickTest Professional add-in from the Mercury Quality Center Add-ins 
page. For more information on installing the add-in, refer to the Mercury 
Quality Center Installation Guide.

The steps in the Cruise Search test are used to create an automated test 
script. In the test plan tree, note that the manual test icon  next to the test 
is now replaced with the automated test icon.

 5 View the test script.

Click the Test Script tab.

To display and modify your test script in the testing tool in which it was 
created, click the Launch button.

Now that you are familiar with creating a test plan tree, designing test steps, 
copying test steps, calling a test with parameters, linking tests to 
requirements, analyzing tests coverage, and automating your manual tests, 
you can proceed to Lesson 4, “Running Tests”. In Lesson 4, you will learn 
how to run your manual and automated tests. 
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4
Running Tests

Running tests is the core of the testing process. As your application changes, 
you run manual and automated tests in your project to locate defects and 
assess quality.

You start by creating test sets and choosing which tests to include in each set. 
A test set is a group of tests in a Quality Center project designed to achieve 
specific testing goals. Quality Center enables you to control the execution of 
tests in a test set by setting conditions and scheduling the date and time for 
executing your tests.

After you define test sets, you can begin to execute your tests. When you run 
a test manually, you execute the test steps you defined in test planning. You 
pass or fail each step, depending on whether the actual results match the 
expected output. When you run a test automatically, Quality Center opens 
the selected testing tool, runs the test, and exports the test results to Quality 
Center. 

In this lesson, you will learn about:

➤ Defining Test Sets

➤ Adding Tests to a Test Set

➤ Scheduling Test Runs

➤ Running Tests Manually

➤ Running Tests Automatically
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Defining Test Sets

After you design tests in the Test Plan module, you create a test sets tree. A 
test sets tree enables you to organize your testing process by grouping test 
sets in folders and organizing them in different hierarchical levels in the Test 
Lab module. Test sets can include both manual and automated tests. You 
can also include the same test in different test sets. 

To decide which test sets to create, think about the testing goals you defined 
at the beginning of the testing process. Consider issues such as the current 
state of the application and the addition or modification of new features. 

Following are examples of general categories of test sets you can create:

In this exercise, you will define the Mercury Tours Site test set.

Test Set Description

Sanity Tests the entire application at a basic level to check that it is 
functional and stable.

Normal Tests the system in a more in-depth manner than the sanity test. A 
Normal test set can contain both positive and negative checks. 
Positive checks test that the application responds to input as 
expected. Negative tests attempt to crash an application to 
demonstrate that the application is not functioning properly.

Advanced Checks the entire application, including its most advanced 
features.

Regression Verifies that a change to one part of the application does not 
prevent the rest of the application from functioning.

Function Tests a specific feature or a group of features in the application.
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To define a test set:

 1 Open the QualityCenter_Demo project.

If the QualityCenter_Demo project is not already open, log on to the 
project. For more information, see “Starting Quality Center” on page 5.

 2 Display the Test Lab module.

Click the Test Lab button on the sidebar. 

 3 Add a folder to the test sets tree.

In the test sets tree in the left pane, select the Root folder.

Click the New Folder button. The New Folder dialog box opens.

In the Folder Name box, type Mercury Tours 1.01 and click OK.

 4 Add a test set to the Test Sets list.

Click the New Test Set button. The New Test Set dialog box opens.
53



Lesson 4 • Running Tests
Type the following:

Test Set Name: Mercury Tours Site

Description: This test set includes tests that verify the functionality of the 
Mercury Tours site.

Click OK. The Mercury Tours Site test set is added to the test sets tree in the 
left pane.

 5 Define the test set details.

Click the Test Set Properties tab and select the Details link. 

By default, the Status indicates that the test set is Open. 

Do the following:

Open Date: Select a date from the calendar. By default, Quality Center 
displays the current date. 

Close Date: Select the planned closing date for the test set.
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 6 Set rules for the automated tests in the test set in the event of a test 
failure. 

Click the On Failure link.

Do the following: 

On automated test failure: Select the first check box and make sure that the 
number of times an automated test can be rerun is set to 1. 

On final test failure: Make sure that the Do nothing option is selected.
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 7 Instruct Quality Center to send an e-mail to specified users if certain 
events occur.

Click the Notifications link. 

Do the following:

Send e-mail in the event of: Select the first check box to send an e-mail 
notification if any test in the test set fails. 

To: Type your e-mail address.

Message: Type the following: 
This test failed. Please review the test results and submit a defect. 
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Adding Tests to a Test Set

After you define a test set, you can add copies of tests from the project to 
your test set. In this exercise, you will add tests to the Mercury Tours Site 
test set.

To add a test to a test set:

 1 Make sure the Test Lab module is displayed.

If the Test Lab module is not displayed, click the Test Lab button on the 
sidebar. 

 2 Display the Execution Grid tab.

In the test sets tree, select the Mercury Tours Site test set and click the 
Execution Grid tab.

 3 Display the test plan tree.

Click the Select Tests button. The right pane displays the test plan tree.
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Note: If any filters are applied, it is recommended that you clear them:

➤ In the test plan tree, click the Set Filter button. In the Filter dialog box, 
click the Clear Filter button.

➤ In the Execution Grid, click the Clear Filter/Sort button and click Yes to 
confirm.

 4 Add the Cruises folder to the test set.

Select the Cruises folder and click the Add Tests to Test Set button. 

Click Yes to confirm. The Parameters of Test dialog box opens because you 
are adding a test with an unassigned parameter value to a test set. Click 
Cancel to close the dialog box. You will assign this parameter value when 
you run the Cruise Booking test (see “Running Tests Manually” on page 66).

The tests are added to the test set.

 5 Add the Airline Preference test to the test set.

To search for the test, in the Find box, type airline and click the Find button. 
The Airline Preference test is highlighted in the test plan tree.

Click the Add Tests to Test Set button. The test is added to the test set.

 6 Add the Number of Passengers test to the test set.

To search for the test, in the Find box, type Number of Passengers and click 
the Find button. The Number of Passengers test is highlighted in the test 
plan tree.

Click the Add Tests to Test Set button. The test is added to the test set.

Tip: You can also add tests by dragging a folder or test in the test plan tree to 
the Execution Grid or Execution Flow.
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 7 Close the test plan tree pane.

Click the Close button. 

Scheduling Test Runs

The Execution Flow tab enables you to specify a date and time to execute a 
test and set conditions for it. A condition is based on the results of another 
specified test in the Execution Flow. By setting conditions, you can 
postpone the execution of the current test until another specified test 
finishes running or passes. You can also set the sequence in which to 
execute the tests. 

For example, you can schedule Test 2 to run only after Test 1 finishes, and 
Test 3 to run only if Test 2 passes. You can also schedule Test 1 and Test 2 to 
run a day before Test 3. The Execution Flow displays the tests and their 
conditions in a diagram. 
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Note: 

➤ A dashed line  arrow indicates a test with no conditions. 

➤ A solid line  arrow indicates a condition and can be blue or 
green. If the solid line is blue, it indicates that the condition status is set 
to “Finished”. If the solid line is green, it indicates that the condition is 
set to “Passed”. 

➤ A Time Dependency  icon is displayed for time dependent tests.

In this exercise, you will create a new test set and add to it three tests that 
verify the login procedure on the Sign-On page of the Mercury Tours site. 
Then, you will set the conditions for each test and specify when each test is 
to be executed.

To schedule a test run:

 1 Make sure the Test Lab module is displayed.

If the Test Lab module is not displayed, click the Test Lab button on the 
sidebar. 

 2 Create a new test set.

In the Test Lab module, click the Execution Flow tab. 
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In the test sets tree, choose the Mercury Tours 1.01 folder and click the New 
Test Set button. The New Test Set dialog box opens.

Type the following:

Test Set Name: Test Run Schedule

Description: This test set is used to explain how to schedule a test run.

Click OK. The Test Run Schedule test set is added to the test sets tree in the 
left pane. 

 3 Add a test from the Sign-On/Sign-Off folder to the Test Run Schedule 
test set.

Click the Select Tests button. The test plan tree is displayed in the right 
pane.

In the Find box in the test plan tree, type sign and click the Find button to 
search for the Sign-On/Sign-Off folder. The Sign-On/ Sign-Off folder is 
highlighted in the test plan tree.

Select the Sign-On Page test. Click the Add Tests to Test Set button. The test 
is added to the test set. 
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 4 Add two additional tests to the test set.

Drag the Sign-On User Name test to the Execution Flow area.

Double-click the Sign-On Password test to add it to the Execution Flow.

 5 Add an execution condition to the Sign-On User Name test.

Right-click the Sign-On User Name test and choose Test Run Schedule. The 
Run Schedule of Test dialog box opens and displays the Execution 
Conditions tab. 
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Click New. The New Execution Condition dialog box opens.

In the Test box, select <[1]Sign-On Page>.

Select Passed to instruct Quality Center to execute the Sign-On User Name 
test only if the Sign-On Page test finishes executing and passes.

Click OK. The condition is added to the Run Schedule of Test dialog box.
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 6 Add a time dependency condition to the Sign-On User Name test.

Click the Time Dependency tab.

Under Run At Specified Time, select the Date check box and select 
tomorrow’s date.

Click OK to close the Run Schedule of Test dialog box. Your conditions are 
displayed in the Execution Flow diagram.

 7 Add an execution condition to the Sign-On Password test.

Add the same execution condition as described in Step 5 on page 62 for the 
Sign-On Password test. This time select Sign-On User Name from the Test 
box in the New Execution Condition dialog box.
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 8 Add a time dependency condition to the Sign-On Password test.

Add the same execution condition as described in Step 6 on page 64 for the 
Sign-On Password test.

Click OK to close the Run Schedule of Test dialog box. Your conditions are 
displayed in the Execution flow diagram.

 9 Rearrange the tests in a hierarchical layout.

Click the Perform Layout button to clearly view dependencies between the 
tests.
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Running Tests Manually

When you run a test manually, you follow the test steps and perform 
operations on your application. Then, you compare the expected results 
with the actual outcome and record the results. You can execute a manual 
test as many times as needed. The results are stored separately for each run. 

Note that you can run both manual and automated tests manually. You can 
also choose to run a single test or to run an entire test set.

In this exercise, you will run the Cruise Booking test.

To run a test manually:

 1 Make sure the Test Lab module is displayed.

If the Test Lab module is not displayed, click the Test Lab button on the 
sidebar. 

 2 Select the Mercury Tours Site test set.

In the test sets tree, select the Mercury Tours Site test set.
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 3 Select the Cruise Booking test from the Execution Grid.

In the Execution Grid tab, select the Cruise Booking test.

Click the Run button. The Manual Runner dialog box opens.
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 4 Start the test run.

Click the Exec Steps button. The Parameters Values for Run dialog box 
opens because you have an unassigned parameter in the test.
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 5 Assign a value for the password parameter.

Click the Value box for password and type the same password you used in 
“The Mercury Tours Sample Web Site” on page 11.

Click OK. The Manual Runner: Step Details dialog box opens.
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 6 Display the Manual Runner dialog box in a compact view. 

Click the Compact View button. This enables you to conveniently read each 
step and record the results.

 7 Perform the first step.

Perform the procedure described in the Description box.

If the actual result is the same as the expected result, in the Actual box, type: 
The Mercury Tours site opens.

Click the Pass selected button. Step 2 is displayed.

 8 Perform the second step.

Perform the procedure described in the Description box.

If the actual result is the same as the expected result, in the Actual box, type: 
The Flight Finder page opens.

Click the Pass selected button. Step 3 is displayed.
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 9 Perform the third step.

Perform the procedure described in the Description box.

If the actual result is the same as the expected result, in the Actual box, type: 
The Cruise Special page opens.

Click the Pass selected button. Step 4 is displayed.

 10 Perform the fourth step.

Perform the procedure described in the Description box.

If the actual result is different than the expected result, in the Actual box, 
type: The Flight Finder page opens instead of the Cruise Reservation page.

Click the Fail selected button. 

Note: When you detect an application flaw while running the test, you can 
click the Add Defect button to open the Add Defect dialog box and add a 
defect. For the purpose of this exercise, you will submit this defect in 
“Adding New Defects” on page 81.

 11 Return to the default display of the Manual Runner.

Click the Back to Steps Grid button. The default display of the Manual 
Runner: Step Details dialog box is displayed. 

 12 End the test run.

Click the End of Run button to end your test run.
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 13 View the test run results in the Execution Grid.

Following the execution of your test, you can view the test run results of 
your last run in the Execution Grid. Note that the test run status is updated 
from “No Run” to “Failed”.

 14 View the results of each test step in the Last Run Result pane.

If the Last Run Result pane is not displayed, click the Show Last Run Result 
button on the bottom of the pane. The Last Run Result pane is displayed 
below the Execution Grid.

Click each step to view the step’s description, as well as the expected and 
actual results.

Note that you can view more detailed results in the Test Run Properties 
dialog box (see “Running Tests Automatically” on page 73).
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Running Tests Automatically

When you run an automated test, Quality Center opens the selected testing 
tool automatically, runs the test on your local machine or on remote hosts, 
and exports the results to Quality Center. 

Note that you can run all tests in a test set or run specific tests. You can run 
tests from the Execution Grid tab or the Execution Flow tab. 

In this exercise, you will run an automated test from the Mercury Tours Site 
test set. After the test run is complete, you will view the test results from the 
Test Run Properties dialog box.

Note: To perform this exercise, you must have one of these tools installed on 
your computer:

➤ QuickTest Professional 

➤ WinRunner 

To integrate Quality Center with QuickTest Professional, you must install 
the QuickTest Professional Add-in and the Mercury Quality Center 
Connectivity Add-in from the Mercury Quality Center Add-ins page. To 
integrate Quality Center with WinRunner, you must install the Mercury 
Quality Center Connectivity Add-in from the Mercury Quality Center 
Add-ins page. For more information, refer to the Mercury Quality Center 
Installation Guide.

To run a test automatically:

 1 Make sure the Test Lab module is displayed.

If the Test Lab module is not displayed, click the Test Lab button on the 
sidebar. 

 2 Display the Mercury Tours Site test set in the Execution Grid.

Click the Execution Grid tab.

In the test sets tree, select the Mercury Tours Site test set.
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 3 Select a test.

To run a WinRunner test, select the Airline Preference test. 

To run a QuickTest Professional test, select the Number of Passengers test.

Click the Run button. The Execution dialog box opens and displays the 
selected test.

 4 Set the test run settings.

Select the Run All Tests Locally check box to run the test on your local 
computer.
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 5 Run the test.

Click the Run button. Quality Center opens the selected testing tool 
automatically and runs the test. You view the test execution progress in the 
Status column.

 6 Close the Execution dialog box.

After the test run is complete, choose Run > Exit.
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 7 View a summary of test results in the Execution Grid. 

The Execution Grid displays the updated status for the test run. Results for 
each test step appear in the Last Run Result pane.
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 8 View detailed test results from the Test Run Properties dialog box.

In the Execution Grid, make sure your test is selected. Click the Test Run 
Properties button. The Test Run Properties dialog box opens and displays 
the All Runs view.

 9 View the test results in your selected testing tool.

➤ To view the test results in QuickTest Professional, click the Launch Report 
button. 

➤ To view the test results in WinRunner, click the View Report button. 

 10 View other test run information in the Test Run Properties dialog box.

➤ To view run details of the test, in the sidebar, click Details.

➤ To view any attachments to a test, in the sidebar, click Attachments.

➤ To view the parameters for a manual or WinRunner test, in the sidebar, 
click Configuration. Note that any changes that you make will be 
implemented in the next test run.
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➤ To view the on failure rules for an automated test, in the sidebar, click 
Run Events. This view also enables you to change your rules. Note that 
any changes that you make will be implemented in the next test run.

➤ To view a list of changes made to the test run fields, in the sidebar, click 
History.

 11 Close the Test Run Properties dialog box.

Choose Run > Exit.

 12 Close your selected testing tool.

In QuickTest Professional or WinRunner, choose File > Exit.

Now that you are familiar with how to define and build test sets, schedule 
test runs, and run tests manually or automatically, you can proceed to 
Lesson 5, “Adding and Tracking Defects”. In Lesson 5, you will learn how to 
add and track defects.
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Adding and Tracking Defects

Locating and repairing defects is an essential phase in application 
development. Defects can be detected and submitted by developers, testers, 
and end users in all stages of the testing process. Using Quality Center, you 
can submit defects detected in the application and track them until they are 
repaired.

In this lesson, you will learn about:

➤ How to Track Defects

➤ Adding New Defects

➤ Matching Defects

➤ Updating Defects

➤ Mailing Defects

➤ Associating Defects with Tests

➤ Creating Favorite Views
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How to Track Defects

When you submit a defect to a Quality Center project, it is tracked through 
these stages: New, Open, Fixed, and Closed. A defect may also be Rejected or it 
may be Reopened after it is fixed.

When you initially report the defect to the Quality Center project, it is 
assigned the status New, by default. A quality assurance or project manager 
reviews the defect and determines whether or not to consider the defect for 
repair. If the defect is refused, it is assigned the status Rejected. If the defect is 
accepted, the quality assurance or project manager determines a repair 
priority, changes its status to Open, and assigns it to a member of the 
development team. A developer repairs the defect and assigns it the status 
Fixed. You retest the application, making sure that the defect does not recur.

If the defect recurs, the quality assurance or project manager assigns it the 
status Reopened. If the defect is actually repaired, the quality assurance or 
project manager assigns it the status Closed.

NewNew

OpenOpen

FixedFixed

ClosedClosed

Reopened

Reject ed
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Adding New Defects

You can add a new defect to a Quality Center project at any stage of the 
testing process. In this exercise you will submit the defect that was detected 
while running the Cruise Booking test. 

To add a new defect:

 1 Open the QualityCenter_Demo project.

If the QualityCenter_Demo project is not already open, log on to the 
project. For more information, see “Starting Quality Center” on page 5.

 2 Display the Defects module.

Click the Defects button on the sidebar. The Defects Grid displays defect 
data in a grid. Each row in the grid displays a separate defect record.
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 3 Open the Add Defect dialog box.

Click the Add Defect button. The Add Defect dialog box opens. Note that 
fields in red are required.

 4 Describe the defect.

Type or select the following:

Summary: Unable to reserve a cruise from the Cruise page. 

Category: Defect

Severity: 2-Medium 

Subject: Cruises 

Detected in Version: Version 1.01 
82



Lesson 5 • Adding and Tracking Defects
Description: The defect was detected in the Cruise Booking test. When you 
click the Now Accepting Reservations button, the Flight Finder page opens 
instead of the Cruise Reservation page.

 5 Attach the URL address for the Mercury Tours page where the defect was 
detected.

Click the Attach URL button. The Attach URL dialog box opens. 

Type the URL address of the Mercury Tours page: 
http://<server name>/mtours/servlet/com.mercurytours.servlet.CruisesServlet

Click OK. The URL is displayed above the Description box.

 6 Spell check your text.

Place the cursor in the Description box and click the Check Spelling button. 
If there are no errors, a confirmation message box opens. If errors are found, 
the Spelling dialog box opens and displays the word together with 
replacement suggestions.

 7 Add the defect to the Quality Center project.

Click the Submit button. 

 8 Close the Add Defect dialog box.

Click Close. The defect is added to the Defects Grid.

Matching Defects

Matching defects enables you to eliminate duplicate or similar defects in 
your project. Each time you add a new defect, Quality Center stores lists of 
keywords from the Summary and Description fields. When you search for 
similar defects, keywords in these fields are matched against other defects.

Note that keywords are more than two characters and letter case does not 
affect your results. Quality Center ignores these articles (a, an, the); 
coordinate conjunctions (and, but, for, nor, or); boolean operators (and, or, 
not, if, or then); and wildcards (?, *, [ ]). 

In this exercise, you will match defects by comparing a selected defect with 
all other existing defects in the QualityCenter_Demo project.
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To match defects:

 1 Make sure that the Defects module is displayed.

If the Defects module is not displayed, click the Defects button on the 
sidebar. 

 2 Select Defect ID 37.

In the Defects Grid, select Defect ID 37. 

Note: If you cannot find Defect ID 37, click the Clear Filter/Sort button to 
clear the filter that is applied to the grid.

 3 Find similar defects.

Click the Find Similar Defects button.

The results are stored in the Similar Defects dialog box, sorted by the 
percentage of detected similarity. 

Close the Similar Defects dialog box.
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Updating Defects

Tracking the repair of defects in a project requires that you periodically 
update defects. You can do so directly in the Defects Grid or in the Defect 
Details dialog box. Note that the ability to update some defect fields 
depends on your permission settings. 

In this exercise, you will update your defect information by assigning the 
defect to a member of the development team, changing the severity of the 
defect, and adding a comment.

To update a defect:

 1 Make sure that the Defects module is displayed.

If the Defects module is not displayed, click the Defects button on the 
sidebar. 

 2 Update the defect directly in the Defects Grid.

In the Defects Grid, select the defect you added in “Adding New Defects” on 
page 81. 

To assign the defect to a member of the development team, in the Assigned 
To box in the defect record, click the down arrow and select james_qc from 
the list.
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 3 Open the Defect Details dialog box.

Click the Defect Details button. The Defect Details dialog box opens. 

 4 Change the severity level of the defect.

In the Severity box, select 5-Urgent.

 5 Add a new comment to explain the change in the severity level.

Click Description in the sidebar.

Click the Add Comment button. A new section is added to the Comments 
box, displaying your user name and the current date.

Type: This defect also occurs in Mercury Tours version 1.0.

 6 View the Attachments.

Click Attachments in the sidebar. Note that the URL attachment is listed.
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 7 View the History.

Click History in the sidebar to view the history of changes made to the 
defect. For each changed field, Quality Center displays the date of the 
change, the name of the person who made the change, and the new value.

 8 Close the Defect Details dialog box.

Click OK to exit the dialog box and save your changes. 

Mailing Defects

You can send an e-mail about a defect to another user. This enables you to 
routinely inform development and quality assurance personnel about defect 
repair activity. Quality Center includes a Go To Defect link in the e-mail, 
which enables the recipient to go directly to the defect.

In this exercise, you will e-mail your defect to your mailbox.

To mail a defect:

 1 Make sure that the Defects module is displayed.

If the Defects module is not displayed, click the Defects button on the 
sidebar. 
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 2 Select a defect.

Select the defect you added in “Adding New Defects” on page 81, and click 
the Mail Defects button. The Send Mail dialog box opens.

 3 Type a valid e-mail address. 

In the To box, type your e-mail address.

 4 Include the attachments and history of the defect.

In the Include box, select Attachments and History.

 5 Add your comments.

Under Additional comments, type: I will send you more information tomorrow.

 6 E-mail the defect.

Click Send. A message box opens. Click OK.

 7 View the e-mail.

Open your mailbox and view the defect you sent.
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Associating Defects with Tests

You can associate a test in your test plan with a specific defect in the Defects 
Grid. This is useful, for example, when a new test is created specifically for a 
known defect. By creating an association, you can determine if the test 
should be run based on the status of the defect. Note that any requirements 
covered by the test are also associated with the defect.

You can also create an association during a manual test run. When you 
submit a defect, an association is created automatically between the test run 
and the new defect.

In this exercise, you will associate your defect with the Cruise Booking test 
in the Test Plan module, and view the associated test in the Defects Grid. 

To associate a defect with a test:

 1 Display the Test Plan module.

Click the Test Plan button on the sidebar. 

 2 Select the Cruise Booking test.

In the test plan tree, under Cruises, expand Cruise Reservation and right-
click the Cruise Booking test. Choose Associated Defects.
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The Associated Defects dialog box opens.

 3 Add an associated defect.

Click the Associate button. The Associate Defect dialog box opens.

Click the Select button. The Associate Defect dialog box opens. 

Select your defect and click the Associate button. 

Note: If you cannot find your defect in the Associated Defect grid, click the 
Clear Filter/Sort button to clear the filter that is applied to the grid.
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Click OK to confirm. Click Close to close the Associate Defect dialog box. 
Your defect is added to the Associated Defects grid.

Click Close to close the Associated Defects dialog box.

 4 View the associated test in the Defects Grid.

Click the Defects button on the sidebar.

Select your defect in the Defects Grid, and choose View > Associated Test. 
The Associated Test dialog box opens.

➤ The Details tab displays a description of the test. 

➤ The Design Steps tab lists the test steps.

➤ The Test Script tab displays the test script if the test is automated. 

➤ The Attachments tab lists any attachments.

➤ The Reqs Coverage tab displays the requirements covered by the test. 

Creating Favorite Views

A favorite view is a view of a Quality Center window with the settings you 
applied to it. For example, in the Defects Grid, you may want to apply a 
filter to display only the defects that were detected by you, are assigned to 
you, or have the status “Not Closed”. 

Note: You can save a favorite view of the Test Grid, Execution Grid, Defects 
Grid, and all Quality Center reports and graphs.

In this exercise, you will create a favorite view in the Defects Grid.

To create a favorite view:

 1 Make sure that the Defects module is displayed.

If the Defects module is not displayed, click the Defects button on the 
sidebar. 
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 2 Define a filter to view defects you detected that are not closed.

Click the Set Filter/Sort button. The Filter dialog box opens. 

Click the Filter Condition box that corresponds to Detected By. Click the 
Browse button. The Select Filter Condition dialog box opens.
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Under Users, select your Quality Center login user name (alice_qc, cecil_qc, 
or michael_qc). Click OK to close the Select Filter Condition dialog box.

For the Status field, click the Filter Condition box. Click the Browse button. 
The Select Filter Condition dialog box opens.

In the right pane, select the logical expression Not.

In the left pane, select Closed. 

Click OK to close the Select Filter Condition dialog box.

Click OK to close the Filter dialog box. The Defects Grid displays the defects 
you detected that are not closed.

 3 Add a favorite view.

Click the Add to Favorites button and choose Add to Favorites. The Add 
Favorite dialog box opens.

In the Name box, type: My detected defects (status ‘Not Closed’).

You can add a favorite view to either a public folder or a private folder. Views 
in the public folder are accessible to all users. Views in the private folder are 
accessible only to the person who created them. For the purpose of this 
exercise, select Private. 
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Click OK. The new view name is added to the Favorite list.

Now that you are familiar with how to add new defects, search for similar 
defects, update defects, e-mail defects, associate defects with tests, and create 
favorite views, you can proceed to Lesson 6, “Tracing Changes”. In Lesson 6, 
you will learn how to trace changes made to your requirements, tests, and 
defects. 
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Tracing Changes

You can instruct Quality Center to create alerts automatically and send e-
mails to notify those responsible when changes occur in your project that 
may impact the testing process. You can also add your own follow up alerts.

To generate automatic traceability alerts, your Quality Center administrator 
can activate traceability notification rules, which are based on associations 
you make in Quality Center between requirements, tests, and defects. When 
an entity in your project changes, you are notified of any associated entities 
that may be impacted by the change. 

Quality Center also enables you to add your own follow up flag to a specific 
test, test instance, or defect to remind yourself to follow up on an issue. 
When the follow up date arrives, Quality Center sends you an e-mail. 

In this lesson, you will learn about:

➤ Triggering a Traceability Alert

➤ Viewing the Traceability Alert

➤ Creating Follow Up Alerts
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Triggering a Traceability Alert

When changes are made to a requirement, test, or defect in your project, 
Quality Center notifies you by adding a trace changes flag to the changed 
entity and/or sending you an e-mail notification. 

Quality Center can generate traceability alerts for these changes:

➤ When a requirement changes (excluding change of status), the designers of 
the associated tests are notified.

➤ When a requirement changes and it has associated tests, all project users are 
notified.

➤ When the status of a defect changes to “Fixed”, the responsible tester of the 
associated test instance is notified.

➤ When a test runs successfully, the users assigned to the associated defects are 
notified.

In this exercise, you will generate a traceability alert for a test by changing 
the associated requirement. To do this, you will log on as a different user 
and make a change to the Cruise Booking requirement. Later, when you log 
on again as yourself, you will see the associated Cruise Booking test flagged.

To trigger a traceability alert:

 1 Log on to the QualityCenter_Demo project as a different user.

If the QualityCenter_Demo project is already open, log off by clicking the 
Logout button on the right side of the window. 

Log on to the QualityCenter_Demo project using a different user name than 
you used in the previous lessons. You can log on as: alice_qc, cecil_qc, or 
michael_qc. 

For more information on opening the QualityCenter_Demo project, see 
“Starting Quality Center” on page 5.
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 2 Display the Test Plan module and view the designer.

Click the Test Plan button on the sidebar. The Test Plan module displays the 
test plan tree. Expand the Cruises and Cruise Reservation subject folders and 
select the Cruise Booking test.

In the Details tab in the right pane, the Designer box displays the user name 
you used to design the Cruise Booking test. Note that when an associated 
requirement changes, the designer is the one who sees the traceability 
notification.

 3 Display the requirements tree.

Click the Requirements button on the sidebar and make sure that the 
Document View of the requirements tree is displayed. 

 4 Select the requirement that you want to change.

Under Cruise Reservation, select the Cruise Booking requirement. 
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 5 Change the priority of the requirement. 

Click the Priority down arrow and select 5-Urgent.

This change causes Quality Center to generate a traceability alert for the test 
associated with this requirement. Quality Center also sends an e-mail to the 
designer of the test. In the next exercise, you will log on as the designer and 
view the traceability alert.

 6 Log off the QualityCenter_Demo project.

Click the Logout button on the right side of the window. 

Viewing the Traceability Alert

You can view traceability changes for a single entity or for all changed 
entities in your project. An entity can be a test, a test instance, or a defect.

In this exercise, you will view the traceability alert for the Cruise Booking 
test that was generated as a result of the change you made to the Cruise 
Booking requirement.

To view the traceability alert:

 1 Log on to the QualityCenter_Demo project as the designer of the Cruise 
Booking test.

Log on to the QualityCenter_Demo project. Make sure you use the same 
name you used in previous lessons as the designer of the Cruise Booking 
test.
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 2 Display the Test Plan module and view the traceability flag.

Click the Test Plan button on the sidebar. In the test plan tree, under 
Cruises, expand Cruise Reservation to display the Cruise Booking test. The 
Cruise Booking test has a trace changes flag, indicating that a change was 
made to an associated requirement. 

 3 View the traceability alert.

Click the Trace Changes flag  for the Cruise Booking test. The Trace 
Changes dialog box opens. 

Click the requirement link. The Cruise Booking requirement is highlighted 
in the Requirements module.

 4 View all traceability alerts.

In the common Quality Center toolbar, click the Trace All Changes 
button.The Trace All Changes dialog box opens and displays a list of all 
traceability changes in your Quality Center project. For this exercise, Quality 
Center displays the same change as above.

Close the Trace All Changes dialog box.
99



Lesson 6 • Tracing Changes
Creating Follow Up Alerts

Quality Center enables you to add your own alerts to remind yourself to 
follow up on outstanding issues. In this exercise, you will add a follow up flag 
to a defect whose status you want to check one week from today. A follow 
up flag is a gray flag icon  that is added to the record. 

When you add a follow up flag, Quality Center also adds an information bar 
that reminds you about the follow up alert. When the follow up date arrives, 
Quality Center sends you an e-mail and changes the flag icon to red.

Note that follow up flags are specific to your user name, meaning that only 
you can see your follow up alerts.

To create a follow up alert:

 1 Display the Defects module.

Click the Defects button on the sidebar.

 2 Select the defect that you want to flag with a follow up reminder.

In the Defects Grid, select a defect.

 3 Create the follow up alert.

Click the Flag for Follow Up button. The Flag For Follow Up dialog box 
opens. 

Do the following:

Follow up by: Select the date one week from today.

Description: Type: Remind me about this defect on this date.
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Click OK. The flag icon  is added to the defect record.

 4 Display the information bar for your follow up alert.

Double-click the defect with the follow up flag. The Defect Details dialog 
box opens and displays an information bar with your follow up alert.

Click Cancel to close the dialog box.

follow up flag

follow up alert 
information bar
101



Lesson 6 • Tracing Changes
Now that you are familiar with tracing changes, you can proceed to 
Lesson 7, “Analyzing the Testing Process” In Lesson 7, you will learn how to 
generate reports and graphs to help you analyze the testing process. 
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Analyzing the Testing Process

Quality Center reports and graphs help you assess the progress of 
requirements, the test plan, test runs, and defect tracking. You can generate 
reports and graphs at any time during the testing process from each Quality 
Center module, using default or customized settings. When customizing a 
report or graph, you can apply filters and sort conditions, and display 
information according to your specifications. You can also save your settings 
as favorite views and reload them as needed. 

In this lesson, you will learn about:

➤ Generating Reports

➤ Generating Graphs

Generating Reports

You can generate a report from any Quality Center module. Each Quality 
Center module contains various report options. After you generate a report, 
you can customize report properties to display information according to 
your specifications.

In this exercise, you will generate a standard requirements report, customize 
the report for a specific user name, and add it to your favorites list.
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To generate a report:

 1 Open the QualityCenter_Demo project.

If the QualityCenter_Demo project is not already open, log on to the 
project. For more information, see “Starting Quality Center” on page 5.

 2 Display the Requirements module.

Click the Requirements button on the sidebar to display the requirements 
tree.

 3 Choose a report.

Choose Analysis > Reports > Standard Requirements Report. The report 
opens, displaying default data. 
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 4 Display the customization options.

Click the Configure Report and Sub-Reports button. The Report 
Customization page opens with the default options selected.

 5 Set the number of items per display page.

Select All items in one page to display all items in one page.
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 6 Define a filter to view requirements created by a specific user name.

Click the Set Filter/Sort button. The Filter dialog box opens. 
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For the Author field, click the Filter Condition box. Click the Browse button. 
The Select Filter Condition dialog box opens.

Under Users, select your Quality Center login user name (alice_qc, cecil_qc, 
or michael_qc). Click OK to close the Select Filter Condition dialog box.

Click OK to close the Filter dialog box.
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 7 Specify the fields and the order in which they are displayed. 

Under Fields, select Custom Fields (layout) and click the Select Fields 
button. The Select Fields dialog box opens. 

The Available Fields box lists fields that are not currently displayed. 
The Visible Fields box lists fields that are currently displayed.

In the Visible Fields box, select Attachment and click the left arrow button 
to move the field to Available Fields. Move Creation Time and Modified to 
Available Fields. 
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To set the appearance order of the visible fields, select ReqID and use the up 
arrow button to move the field under Author. Move Name and Description 
so that they appear below ReqID.

Tip: You can also use a drag-and-drop operation to specify visible fields and 
the order in which they are displayed.

Click OK to close the dialog box and apply the new field order.

 8 Clear the Attachments and History options.

Under Fields, clear the Attachments and History check boxes.
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 9 Generate a new report.

Click the Apply button. The customized Requirements Report is displayed. 

 10 Add the report as a favorite view.

Click the Add to Favorites button. The Add Favorite dialog box opens.

In the Name box, type: Standard Requirements by Author. Click OK. The 
report is added to the Reports list in the left pane.

 11 Close the report.

Click the Close button. The Requirements module is displayed.

Tip: You can generate a quick report for a single node in a tree or row in a 
grid. Select the requirement, test, or defect, and choose Analysis > 
Report Selected.
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Generating Graphs

Quality Center graphs help you analyze the relationships between different 
types of data in a project. Each Quality Center module contains various 
graph options. After you generate a graph, you can customize graph 
properties to display information according to your specifications. 

In this exercise, you will generate a defects graph to summarize the defects 
by status and priority level.

To generate a graph:

 1 Display the Defects module.

Click the Defects button on the sidebar. The Defects module displays the 
Defects Grid.

 2 Choose a graph.

Choose Analysis > Graphs > Summary - Group by ‘Status’. The Defects -
Summary Graph opens. By default, the graph is grouped by Status.
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 3 Clear the default filter.

Click the Filter button. The Filter dialog box opens. 

By default, the Detected By field is set to the current user name—
your Quality Center login user name (alice_qc, cecil_qc, or michael_qc).

Click the Clear Filter button. The applied filter is removed.
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 4 Define a filter to view defects with high to urgent priority.

In the Filter dialog box, for the Priority field, click the Filter Condition box. 
Click the Browse button. The Select Filter Condition dialog box opens.

In the right pane, select the logical expression >=.

In the left pane, select 3-High.

Click OK to close the Select Filter Condition dialog box.

 5 Define a filter to view defects that are not closed.

For the Status field, click the Filter Condition box. Click the Browse button. 
The Select Filter Condition dialog box opens.

In the right pane, select the logical expression Not.

In the left pane, select Closed. 

Click OK to close the Select Filter Condition dialog box.

Click OK to close the Filter dialog box.
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 6 Set the X-axis of the graph.

From the X-Axis list on the right side of the window, select Priority to view 
the number of defects by priority.

 7 Refresh the graph.

Click the Refresh button. A new graph is displayed. 

In this exercise, nine defects are assigned 3-High; eight defects are assigned
4-Very High; and one defect is assigned 5-Urgent.
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 8 Display additional defect details.

Click a bar segment in the graph. The Drill Down Results dialog box opens 
and displays the defects that define the bar segment. 

Close the Drill Down Results dialog box.

 9 Display other graph views.

Click the Pie Chart tab to display the graph as a pie graph.

Click the Data Grid tab to display the graph as a grid.

 10 Close the graph.

Click the Close button. The Defects module is displayed.

Now that you are familiar with generating reports and graphs, you can 
proceed to Lesson 8, “Where Do You Go from Here?”. In Lesson 8, you will 
apply the Quality Center concepts and skills you learned to your own 
application. 
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8
Where Do You Go from Here?

Now that you have completed the tutorial, you are ready to apply the 
Quality Center concepts and skills you learned to your own application. 

In this lesson, you will learn about:

➤ Getting Started

➤ Getting Additional Information

Getting Started

Test management with Quality Center includes four phases: specifying 
requirements, planning tests, running tests, and tracking defects. 
Throughout each phase, you can analyze data by generating detailed reports 
and graphs.

To get started:

 1 Analyze your application and determine your testing requirements.

To specify your testing requirements, consider these steps:

➤ Examine the application documentation to determine your testing 
scope—test goals, objectives, and strategies.

➤ Build a requirements tree to define your overall testing requirements.

➤ For each requirement topic in the requirements tree, create a list of 
detailed testing requirements. Describe each requirement, assign it a 
priority level, and add attachments if necessary.
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➤ Generate reports and graphs to assist you in analyzing your testing 
requirements. Review your requirements to ensure they meet your 
testing scope.

 2 Create a test plan, based on your testing requirements.

To create a test plan, consider these steps:

➤ Examine your application, system environment, and testing resources to 
determine your testing goals.

➤ Divide your application into modules or functions to be tested. Build a 
test plan tree to hierarchically divide your application into testing units, 
or subjects.

➤ Determine the types of tests you need for each module. Add a basic 
definition of each test to the test plan tree.

➤ Link each test to a testing requirement(s).

➤ Develop manual tests by adding steps to the tests in your test plan tree. 
Test steps describe the test operations and the expected outcome of each 
test. Decide which tests to automate.

➤ Create test scripts for tests that you want to automate. You can automate 
tests using a Mercury testing tool, a custom testing tool, or a third-party 
testing tool.

➤ Generate reports and graphs to assist in analyzing test planning data. 
Review your tests to determine their suitability to your testing goals.

 3 Create test sets and perform test runs.

➤ Define groups of tests to meet the various testing goals in your project. 
These might include, for example, testing a new application version or a 
specific function in an application. Decide which tests to include in each 
test set.

➤ Schedule test execution and assign tasks to application testers. 

➤ Execute the tests in your test set automatically or manually.

➤ View the results of your test runs to determine if a defect was detected in 
your application. Generate reports and graphs to help analyze these 
results.
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 4 Submit defects detected in your application and track the progress of 
defect fixes.

➤ Submit new defects detected in your application. Quality assurance 
testers, developers, project managers, and end users can add defects 
during any phase of the testing process.

➤ Review new defects and determine which ones should be fixed.

➤ Correct the defects that you decide to fix.

➤ Test a new build of your application. Repeat this process until defects are 
fixed.

➤ Generate reports and graphs to assist in analyzing the progress of defect 
fixes and to help determine when to release the application.

Getting Additional Information

For more information on Quality Center, refer to the documentation set and 
online resources.

Mercury Quality Center Documentation Set

In addition to this guide, Quality Center comes with the following printed 
documentation:

Mercury Quality Center Installation Guide explains how to install Quality 
Center on a server machine in a cluster environment or as a stand-alone 
application.

Mercury Quality Center User’s Guide explains how to use Quality Center to 
organize and execute all phases of the testing process. It describes how to 
define requirements, plan tests, run tests, and track defects.

Mercury Quality Center Administrator’s Guide explains how to create and 
maintain projects using the Site Administrator, and how to customize 
projects using Project Customization.
119



Lesson 8 • Where Do You Go from Here?
Mercury Quality Center Open Test Architecture Guide explains how to use 
the Quality Center open test architecture to integrate your own 
configuration management, defect tracking, and home-grown testing tools 
with a Quality Center project. It includes a complete reference to the 
Quality Center COM-based API.

Mercury Quality Center Site Administrator Client API Guide explains how to 
use the Site Administrator Client API to enable your application to organize, 
manage, and maintain all users, projects, domains, connections, and site 
configuration parameters. It includes a complete reference of all the Site 
Administrator Client functions.

Mercury Business Process Testing User’s Guide explains how to use Business 
Process Testing to create business process tests. 

Online Resources

Quality Center includes the following online resources:

Readme provides last-minute news and information about Quality Center.

What’s New describes the newest features in the latest versions of Quality 
Center.

Books Online displays the complete documentation set in .PDF format. 
Online books can be read and printed using Adobe Reader which can be 
downloaded from the Adobe Web site (http://www.adobe.com).

Quality Center Online Help provides immediate answers to questions that 
arise as you work with Quality Center. It describes menu commands and 
dialog boxes, and shows you how to perform Quality Center tasks. Check 
the Mercury Interactive Customer Support Web site 
(http://support.mercury.com) for updates to Quality Center help files.

Customer Support Online uses your default Web browser to open the 
Mercury Interactive Customer Support Web site. This site enables you to 
browse the Mercury Support Knowledge Base and add your own articles. You 
can also post to and search user discussion forums, submit support requests, 
download patches and updated documentation, and more. The URL for this 
Web site is http://support.mercury.com.
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Mercury Interactive on the Web uses your default Web browser to open 
Mercury Interactive’s home page. This site provides the most up-to-date 
information on Mercury Interactive and its products. This includes new 
software releases, seminars and trade shows, customer support, educational 
services, and more. The URL for this Web site is http://www.mercury.com.
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